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Nota Introdutdria
Antes de iniciar o trabalho com o software SketchUp 8, convém alargar o conjunto

de opgdes da barra de ferramentas. Assim, no menu "View", submenu "Toolbars":

1. Desseleccione a op¢do "Getting Started" (a barra de ferramentas desaparece)
2. Selecione a opcao "Large Toolset" (surge nova barra de ferramentas, mais com-

pleta)
3. Movimente, se necessario, a nova barra de ferramentas para a parte superior da

janela de trabalho.



1 Manual de Instalacéao

Para instalar o SketchUp 8 no seu PC ou Mac, tera de descarregar primeiro a aplicagdo da
Internet. Para tal, abra o seu navegador e coloque o0 seguinte enderego:

http://www.sketchup.com/download/all

Em seguida escolha o idioma que pretende que seja usado na ferramenta e a versao
adequada ao seu sistema (Windows para PC, Mac OS X para Mac). A versdo da aplicagao
a descarregar é SketchUp 8 (ignore todas as outras versoes). Aguarde até que a transfe-

réncia termine.

MacOS X Windows Terms of Service
SketchUp Pro 2013 Download Download Terms and Conditions
SketchlUp Make 2013 Download Download Terms and Conditions
SketchlUp Viewer Download Download Terms and Conditions
SketchUp Pro 8 Download Download Terms and Conditions
SketchlUp 8 Download Download Terms and Conditions
SketchlUp Pro 7 Download Download

Figura 1 - Opgdo de descarga

Quando a transferéncia terminar, execute o instalador. Devera surgir um ecrd como o
apresentado na 36. Siga as instrugdes apresentadas e clique sempre em “Next” e “Ins-

tall”, no passo a

Welcome to the SketchUp 8 Setup Wizard

The Setup Wizard will install SketchUp 8 on your computer.
Click Mext to continue or Cancel to exit the Setup Wizard.

Figura 2 - Ecrad inicial do instalador


http://www.sketchup.com/download/all

ApOs a aplicagdo estar instalada, devera aparecer um atalho no ambiente de trabalho,36.
Execute a aplicagdo. A primeira vez que o SketchUp é executado, é-lhe pedido que esco-
lha um “template”. Este sera o ambiente inicial do SketchUp das préximas vezes que este
for aberto. Sugerimos que selecione a opgao “Simple Template - Meters”, que apresenta
um “template” simples, com o sistema de medigdo baseado em metros (Figura 4). Para
terminar, clique em “Start using SketchUp”.

B SketchU | ' s
Interested in SketchUp Pro 87 S .

Default Template: Simple Template - Me i Choose Template

b Learn

¥ Template
Template Selection: @

Simple Template - Feet and Inches
Units: Inches
This is & general-use modeling template with basic styling and simple colors.

Simple Template - Meters:
Units: Meters
This is a general-use modeling template with basic styling and simple colors,

Architectural Design - Feet and Inches
Units: Inches
- ; This template is for anchitectural and interior design.

Architectural Design - Millimeters
Units: Millimeters
This template is for anchitectural and interior design.

[ Always show on startup Start using SketchUp

Figura 4 - Escolha do “template”



2 Sistema de Coordenadas

Um sistema de coordenadas é uma forma de definir inequivocamente um ponto no espa-
¢o através de um conjunto de valores.

Aqui iremos utilizar as coordenadas cartesianas. Neste sistema de coordenadas, um pon-
to é definido por um conjunto de 3 valores em que cada um corresponde ao valor que
toma a projecao do ponto no eixo do X, do Y e do Z. No software SketchUp, os trés eixos

sdo marcados com cores vermelho, verde e azul.

Figura 5 - Sistema de coordenadas cartesiano

No SketchUp, para marcarmos um ponto com as coordenadas desejadas, devemos utili-

zar a ferramenta “Tape Measure”.
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Figura 6 - Ferramenta “Tape Measure”

Marca-se primeiro o ponto a partir do qual se quer medir a distancia (o ponto origem) e
move-se o rato até ao ponto pretendido.

Esta ferramenta também pode ser usada para criar pontos a distancias fixas de outros:
marca-se o ponto origem e usa-se o rato para definir a direcdo; com o teclado insere-se
a distancia exata pretendida.

Com esta ferramenta é também possivel criar retas auxiliares, muito importantes para

modelar com precisao. Para criar uma destas retas, basta escolher a ferramenta “Tape



Measure” e clicar sobre uma aresta do modelo. De seguida, é possivel definir uma reta
auxiliar paralela a essa aresta, podendo para isso mover o rato ou introduzir uma medida
precisa. O SketchUp é capaz de utilizar essas retas auxiliares como guias para as suas
varias ferramentas de desenho, podendo ser isto utilizado, por exemplo, para posicionar

as janelas de uma casa.

Figura 7 - Criacdo de uma reta auxiliar



3 Formas 2D

Um poligono é uma figura geométrica plana (2D) limitada por uma linha poligonal fecha-

da. Por exemplo, o hexagono é um poligono de seis lados.

Os poligonos podem ter todos os lados iguais tomando, neste caso, a classificagdo de re-

gulares; se tiverem lados de diferentes comprimentos, dizem-se irregulares.

No SketchUp, os poligonos podem ser feitos com base em varias ferramentas diferentes

e ainda se podem fazer linhas curvas:

Line - Linha
Rectangle - Retangulo
Circle - Circulo

Arc - Arco

Polygon - Poligono

3.1 Linhas

Com a ferramenta “Line” é possivel tracar uma sequéncia de linhas retas, as quais de-

vem definir uma linha fechada de forma a formar um poligono.
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Figura 8 - Ferramenta "Line"

Figura 9 - Poligono formado com a ferramenta "Line"



3.2 Retangulos

Com a ferramenta “Rectangle” podemos definir poligonos retangulares de varios tama-

nhos, bastando para isso "clicar" num vértice e arrastar.

A C

Figura 10 - Ferramenta "Rectangle"

Figura 11 - poligono formado com a ferramenta "Rectangle"

3.3 Circulos

Com a ferramenta “Circle” é possivel desenhar circulos de varios tamanhos, bastando pa-

WA O4

ra isso "clicar" e arrastar.

Figura 12 - Ferramenta "Circle"

Figura 13 - Poligono formado com a ferramenta “Circle”



3.4 Arcos

A ferramenta “Arc” possibilita a criagdo de um arco entre dois pontos. Para efetuar esta
operagcao devemos primeiramente marcar com o rato os dois pontos, entre os quais o ar-
co se situara. De seguida, "clica-se" sobre o ponto médio da linha que se forma e arras-

ta-se até se atingir a amplitude desejada do arco.

Figura 14 - Ferramenta "Arc"

Figura 15 - Poligono formado com a ferramenta "Line" e "Arc"

3.5 Poligonos Regulares

Utilizando a ferramenta “Polygon” podemos criar qualquer poligono regular, bastando pa-
ra isso selecionar a ferramenta, selecionar o numero de lados no canto inferior esquerdo
da janela e, de seguida, "clicar" e arrastar. Podem seguir-se outros poligonos semelhan-
tes; para alterar, por exemplo, para 10 lados escreve-se, no canto inferior esquerdo,
"10s".

B/0CO®

Figura 16 - Ferramenta "Polygon"

Figura 17 - Poligono formado com
a ferramenta “Polygon”



4 Formas 3D com Extrusao Linear

A extrusdo é o processo através do qual se efetua o varrimento espacial de um poligono
previamente definido. Isto &, partindo de um poligono “desenhado” em 2D, podemos ar-

rasté-lo de forma a obter um sélido em 3D.

Para fazer extrusdao no SketchUp, partindo de poligonos ja presentes, basta "clicar" sobre

o poligono com a ferramenta “Push/Pull” e arrastar na direcdo em que se pretende pro-

EOEEEYG

jetar o poligono.

Figura 18 - Ferramenta “Push/Pull”
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Figura 19 - Extrusdo realizada com ferramenta "Push/Pull" no SketchUp

Podemos, por exemplo, a partir de um retdngulo, obter um paralelepipedo; a partir de

um circulo, obter um cilindro, etc.

Figura 20 - Adigdo de volume a um reténgulo utilizando a ferramenta Push/Pull



Este modificador também serve para criar “buracos”, ou seja, para subtrair volu-
me num sélido ja existente, como se vé no exemplo da Erro! A origem da referéncia

ao foi encontrada..

|
|
+
&
———

Figura 21 - Subtracdao de volume utilizando a ferramenta Push/Pull
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5 Transformacdes Geomeétricas

Transformagao geométrica € uma operacdo efetuada sobre uma figura de forma que a
sua geometria seja alterada. De acordo com a operacgao, a figura pode ser rodada, au-

mentada ou diminuida de tamanho, etc...

As transformagOes geomeétricas principais sdo as seguintes:
e Translagao
e Rotacao

e Escalamento

Vamos entdo fazer uma incursdo por essas transformacgBes geométricas, explicando o

que sdo e como as efetuar no SketchUp.

5.1 Translacao

A translacdo corresponde a movimentar um objeto de um ponto a outro. Consiste em
tomar um objeto inicial e mové-lo para outra posicdo sem qualquer alteragao a sua forma

geomeétrica, tal como se pode ver na Figura 22.

Z

Figura 22 - Translacdo de um objeto

Por forma a efetuar uma translagdo, devemos selecionar o objeto que ird sofrer a trans-
lacdo e, de seguida, com a ferramenta “Move/Copy”, "clicar" sobre o objeto e arrasta-lo
para o local desejado. Carregando no “Ctrl” quando se usa esta ferramenta cria-se uma

copia do objeto original.
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Figura 23 - Ferramenta “Move/Copy”

Pode ver-se na Figura 24 a translacao de um paralelepipedo realizada no SketchUp.

Figura 24 - Translacdo de um paralelepipedo.

5.2 Rotacgéao

A operacdo de rotacao consiste em rodar um objeto em torno de:
¢ Um ponto, para operagdes e objetos em 2D

¢ Um eixo no caso de operagdes e objetos em 3D.

Em 3D, o eixo de rotacdo podera ser:
e Um dos eixos do sistema de eixos x, y ou z

e Um eixo colocado arbitrariamente no espaco

Em tornodoeixoZ 2> Z Em torno do eixo X = X Em tornodoeixoY =>Y
constante constante constante
+ _+
>
+ X 1 i8¢ X
<:L
z z r4

Figura 25 - Rotacdo em torno dos eixos Z, X e Y.

Por forma a efetuarmos uma rotacao no SketchUp, comecamos por selecionar o objeto a
rodar e, com a ferramenta “Rotate”, "clicamos" sobre dois pontos a escolha, que defini-

rao o eixo de rotacao.
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Figura 26 - Ferramenta “Rotate”.

Seguidamente move-se o ponteiro livremente até a posicao desejada.

Na Figura 27 pode ver-se a rotagao de um objeto sobre um eixo paralelo ao eixo Y, cen-

trado no préprio objeto.

Figura 27 - Rotagdo de um objeto no SketchUp

5.3 Escalamento Simples

A operacdo de escalamento baseia-se em alterar o tamanho de determinado objeto.

y

Z
Figura 28 - Escalamento de um objeto.

Como se pode ver na Figura 28, partindo de um objeto, obtém-se um outro objeto maior

(ou menor...) mas sem que a sua forma sofra qualquer alteragao.

Para efetuar o escalamento de uma “pega” desenhada no SketchUp é necessario selecio-
nar primeiramente todo o objeto com a ferramenta de selegao. Depois, com a ferramenta
“Scale”, seleciona-se um dos vértices da caixa que se forma a volta do objeto (vértice da

direita, a vermelho, na Figura 31) e arrasta-se com o rato, de modo a obter o tamanho

13



pretendido.

Figura 29 - Ferramenta “Scale”.

Figura 30 - Objeto original.

Figura 31 - Objeto original selecionado com a ferramenta “Scale”.

Figura 32 - Objeto escalado (reduzido)

14



5.4 Exercicio

Modelacao e Transformacoes Geométricas - Modelando uma casa

1. Corpo da casa: Aplicacdo da ferramenta Push/Pull
a. Desenhe um retangulo e aplique a ferramenta Push/Pull para gerar o volume
da casa.
b. Modele as janelas e a porta da casa. (Nota: desenhe retangulos nas faces do
paralelepipedo e depois aplique a ferramenta Push/Pull).

Figura 33 - Exercicio de aplicagdo da ferramenta Push/Pull
2. Telhado: Aplicacdo da translacdo de arestas e faces

a. Em primeiro lugar é necessario desenhar uma linha que divida a face superior
do paralelepipedo a meio:

Figura 34 - Exercicio de aplicacdo da translagdo de arestas e faces - parte 1

15



b. De seguida é necessario aplicar, a aresta criada, a ferramenta de translacdo,
de modo a ficar como na figura seguinte:

Figura 35 - Exercicio de aplicacdo da translagdo de arestas e faces - parte 2

c. Podemos agora baixar o “telhado” de modo a ficar uma casa um pouco mais
proporcional. Da mesma forma que utilizdmos a translacdo para mover uma
aresta, vamos agora utiliza-la para mover as faces do “telhado”. O objetivo é
obter um resultado semelhante ao da figura seguinte.

Figura 36 - Exercicio de aplicagdo da translacdo de arestas e faces — parte 3

16



3. Modele novamente a casa do exercicio anterior, usando desta vez as medidas indica-
das abaixo. Deve usar a ferramenta “Tape Measure” para criar as retas auxiliares ne-
cessarias para alinhar todos os componentes do modelo.

Figura 37 - Medidas exatas a utilizar

4. Utilizando o modelo da casa do exercicio anterior crie agora um bairro, com pelo
menos quatro casas, dispostas dos dois lados de uma rua. Tome atencao a orientagao
de cada casa, a face que contém a porta deve estar sempre voltada para a rua.

a.

Para copiar o modelo da casa, deve em primeiro lugar escolher a ferramenta

de selecao.
Em seguida clique trés vezes sobre o modelo da casa, ficando assim todo o
modelo selecionado (com uma sombra azul).

Figura 38 - Modelo da casa selecionado

17



Para criar uma nova copia do modelo basta carregar nas teclas “Ctrl” e “C” em
simultaneo (copia o modelo), e em seguida carregar nas teclas “Ctrl” e “V” em
simultaneo (cola o0 modelo). Repetir este processo pelo menos quatro vezes,
se em seguida utilizar as ferramentas “Translate” e “Rotate” para posicionar
as casas corretamente.

Figura 39 - Resultado final da criagdo de um bairro

18



6 Os modificadores

Os modificadores sao operadores do software SketchUp que obrigam a uma alteragao da
estrutura do objeto, isto €, algumas ou todas as distancias relativas entre os seus vérti-
ces sdo alteradas e/ou sdo criados novos Vvértices, arestas e faces. Entre os modificado-
res existentes sao de destacar:

e Push/Pull: adicionar ou subtrair volume a objetos 3D (ja visto anteriormente).

e Follow me: duplicacao de um perfil ao longo de um determinado caminho.

e Offset: criacao de linhas ou faces a uma disténcia uniforme das originais.

e Operadores Booleanos: intersecdo e diferenca de objetos 3D.
Ainda existem outros tipos de modificadores associados as transformagdes geométricas,

nomeadamente ao escalamento e a translagao.

6.1 Follow me

Este modificador utiliza a Follow me Tool (Figura 40) e permite efetuar uma extru-

sao angular propagando um perfil ao longo de um determinado caminho circular.
L AR F
XL s
Figura 40 - Ferramenta Follow me no Google SketchUp

Como exemplo, imaginemos a criagcdo de um cone a partir de uma circunferéncia e de

um tridngulo como se apresenta na Figura 41.

Figura 41 - 1° passo da utilizacdo da ferramenta Follow me

Neste caso, queremos "rodar" o triangulo ao longo da circunferéncia, de modo a formar
um cone. Comegamos por "clicar" com a Follow me Tool no triangulo e de seguida no

caminho que queremos que ele percorra, ou seja, o circulo.
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Figura 42 - Modo de utilizagdo da ferramenta Follow me

6.2 Offset

Este modificador utiliza a Offset Tool e permite criar poligonos e linhas a uma certa dis-

xs2350@

Figura 43 - Ferramenta Offset no SketchUp

tancia dos originais.

Este modificador é particularmente Util quando, por exemplo, queremos criar uma face
cujas arestas estejam todas a mesma distancia das arestas da face onde foram desenha-
das.

O modo de utilizacdo desta ferramenta é bastante simples: basta "clicar", com a ferra-

menta selecionada, na aresta ou na face a qual se deseja aplicar o modificador.

Figura 44 - Modo de utilizagdo da ferramenta Offset

6.3 Operadores Booleanos

Os operadores Booleanos permitem combinar objetos para formar outros, mais comple-
x0s. Existem trés tipos de operadores Booleanos:
e Intersecdo: Dados dois objetos A e B, da sua intersecao resulta um objeto C
constituido pelo volume que é comum aos dois objetos originais.
e Unido: Dados dois objetos A e B, da sua unido resulta um objeto C constituido

pelo volume que corresponde a juncdo dos dois objetos originais. Esta operacdo,

20



no SketchUp, ndo estd tdo explicita como as restantes, uma vez que existem ou-
tras ferramentas, como a Push/Pull Tool, que fazem algo parecido com a unido de
objetos.

e Diferenca: Dados dois objetos A e B, da sua diferenca C=A-B resulta um objeto
C constituido pela subtracdo dos dois objetos originais, na ordem especificada. Es-
ta operacdo ndo é comutativa, pelo que resulta um objeto diferente se se fizer a

subtracao complementar, ou seja, C=B-A.

Nas subseccdes seguintes descrevem-se estes operadores com mais detalhe, por recurso

a exemplos e ao SketchUp.

6.3.1 Operadores Booleanos no SketchUp

6.3.1.1 Intersegao

Dados os poligonos A e B, na seguinte posicdo (figura da esquerda), a sua intersegdo re-

sulta no poligono visivel no lado direito.

Figura 45 - A intersecdao em 2D

No SketchUp, a intersecdo realiza-se recorrendo a ferramenta Intersect, acessivel atra-
vés de um "cligue" no botdo direito do rato, sobre um objeto.
Para ilustrar este operador, imaginemos que temos dois objetos: um cilindro e um para-

lelepipedo.

21



Figura 46 - Objetos exemplo - Cilindro e Paralelepipedo

Colocando-os de forma a que tenham pontos em comum ficam:

Figura 47 - Objetos exemplo numa posicdo onde existem pontos comuns entre si

"Clicando" com o botdo direito em cima de um dos objetos e fazendo Intersect -> with
model e apagando as arestas fora da intersecao, com a Eraser Tool, resulta no seguinte

objeto:

Figura 48 - Resultado da intersecao dos objetos exemplo

6.3.1.2 Diferencga

A nivel 2D, dados os mesmos poligonos do exemplo anterior, podemos obter os seguin-

tes resultados:

22



Figura 49 - A diferengca em 2D

No SketchUp, a diferenca de objetos faz-se exatamente da mesma forma que a interse-
cao mudando apenas as arestas que apagamos apés a aplicacdo da ferramenta Intersect.
Para ilustrar este operador imaginemos o cilindro e o paralelepipedo do exemplo anterior,
colocados exatamente nas mesmas posigoes.

Através da aplicacdo deste operador temos dois resultados possiveis, de acordo com a
ordem de subtracdo. A Figura 50 mostra o resultado da subtragdo "paralelepipedo menos

cilindro".

Figura 50 - Objeto resultante da subtragdo do cilindro ao paralelepipedo

A Figura 51 mostra o resultado da subtracgdo "cilindro menos paralelepipedo”.

Figura 51 - Objeto resultante da subtragdo do paralelepipedo ao cilindro

6.3.1.3 Uniao

Dados os poligonos A e B, na seguinte posigdo (figura da esquerda), a sua unido resulta

no poligono visivel no lado direito.

23



No SketchUp, é apenas necessario fazer com que dois objetos se toquem para os juntar,
“colando-0s” um ao outro.

Figura 52 - Objetos exemplo numa posicdo onde existem pontos comuns entre si

Embora os dois objetos estejam a partir desse momento interligados, ndo se trata de
uma verdadeira unido de sélidos, uma vez que ndo foram criadas novas arestas onde as
faces de ambos os sélidos se cruzam. Assim, a unido pode ser concluida "clicando" com o
botdo direito em cima de um dos objetos e fazendo Intersect -> with model, resultando

no seguinte objeto:

24



Figura 53 - Objeto criado pela unido de dois objetos, com novas arestas criadas nas faces que se
intersetam

6.4 Escalamento de faces

O escalamento, como ja vimos anteriormente, é uma transformacdo geométrica. No en-
tanto, o SketchUp permite escalar faces isoladamente, o que resulta como um modifica-

dor. Vejamos o seguinte objeto da Figura 54:

Figura 54 - Paralelepipedo exemplo

Ao aplicarmos um escalamento de reducdo a face superior, de acordo com a Figura 55...

25
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Figura 55 - Escalamento da face superior

...resulta o objeto da Figura 56.

Figura 56 - Objeto resultante do escalamento da face superior

6.5 Translacao de Arestas e Faces

Tal como no caso do escalamento, a translacdo também pode atuar como um modifica-
dor podendo ser aplicada a uma face ou aresta de um objeto. Tomando como exemplo o
mesmo objeto da seccdo anterior, e aplicando uma translacao a face superior, podemos

obter o objeto da Figura 57.

26



Figura 57 - Translagdo da face superior do paralelepipedo exemplo

Se a translacgdo for aplicada a uma aresta, é possivel obter, por exemplo, o objeto da Fi-
gura 58. Esta facilidade ja foi utilizada anteriormente para se fazer a casa das figuras
36-36.

On BIUEE

Figura 58 - Translacdo de uma aresta do paralelepipedo exemplo
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6.6 Exercicios sobre modificadores

1. Operagdes Booleanas e escalamento de faces. Utilizando um cilindro e um paralele-
pipedo iremos aplicar os modificadores referidos de modo a obtermos uma ponte de
arco.

a. Em primeiro lugar, é necessdrio desenhar um paralelepipedo, com uma pe-
guena depressado no topo (mais tarde sera a estrada sobre a ponte).

Figura 59 - Forma basica do tabuleiro da ponte

b. De seguida é necessario desenhar um cilindro e posiciona-lo intercetando o
paralelepipedo como mostra a figura.

Figura 60 - Aplicacdo de operégées booleana e escalamento de faces - parte 2

c. Finalmente, iremos efetuar a subtragdo "seccdo da ponte = paralelepipedo -
cilindro", de modo a obtermos a seccao da ponte.
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Figura 61 - Aplicacdo de operagdes booleana e escalamento de faces - parte 3

d. Copiando e juntando vdrias sec¢Oes da ponte, obtemos a ponte completa.
Nao esquecer de usar a Eraser Tool no final para apagar todas as linhas des-
necessarios que sao criadas ao juntar duas secgdes.

Figura 62 - Resultado final da construgdo de uma ponte

2. Utilizagao da ferramenta Offset.

a. Parailustrarmos a utilizacdo desta ferramenta imaginemos que queriamos fa-
zer um modelo 3D do Empire State Building (http://www.esbnyc.com). Um
modelo simplista do edificio podia ser feito dispondo paralelepipedos em tor-
re (maiores por baixo). Uma forma de fazer isto em Sketchup é utilizar a fer-
ramenta Offset para desenhar facilmente o paralelepipedo superior a uma
distancia uniforme do de baixo. O objetivo deste exercicio é fazer um modelo
simplista do Empire State Building. O resultado esperado é semelhante ao
apresentado na figura seguinte.
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Figura 63 - Aplicacdo da ferramenta Offset

3. Utilizacao da ferramenta Follow Me. Neste exercicio o objetivo é construir um calice.
a. O primeiro passo é saber que poligonos utilizar. Como o calice tem uma su-
perficie curva é necessario usar um circulo como caminho a percorrer. E tam-
bém necessario desenhar metade do perfil do cdlice, para que a ferramenta
Follow Me o possa criar por arraste. O primeiro passo é dispor um circulo e
um retangulo da seguinte forma:

Figura 64 - Aplicagdo da ferramenta Follow Me - parte 1

b. De seguida é necessario desenhar metade do perfil do calice, e apagar todas
as linhas desnecessarias, incluindo os lados do retangulo.
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Figura 65 - Aplicagdo da ferramenta Follow me - parte 2

c. Por fim, deve selecionar-se o circulo, escolher a ferramenta Follow Me e fi-
nalmente clicar no perfil do cdlice. O perfil vai ser arrastado pelo caminho de-
finido pelo circulo, criando assim o célice.

Figura 66 - Resultado final da construgdo de um calice
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7 Texturas

As texturas sdo utilizadas em Computagdo Grafica como forma de aumentar o realismo
de um objeto. Com as texturas podemos, ndo sé dar cor aos objetos, como também lhes

dar algum relevo.

7.1 Mapeamento de texturas

Para aplicar uma textura a um objeto, a textura tem que ser mapeada sobre os poligonos
que compdem esse objeto. Entdo, para cada poligono é necessario aplicar a porgao da

textura correspondente a esse poligono.

Figura 67 - Textura Exemplo

Figura 68 - Poligono Retangular

Imaginemos que temos a textura representada na Figura 67 e a queremos mapear num
poligono retangular, por exemplo o da Figura 68. Para fazer isso sera necessario dizer
como sera “colada” a textura sobre o poligono, tal como se a textura fosse um papel de
parede. Quando se cola papel de parede, comeca-se por acertar as pontas nas posigoes
gue se deseja; aqui vamos fazer exatamente o mesmo, ou seja, vamos fazer correspon-
der na textura um sistema de coordenadas idéntico ao que se da em matematica sé que
em vez de “X”,”Y” temos o “s” e “t” para distinguir do sistema de coordenadas do poligo-
no, como se pode ver na Figura 69. Agora que sabemos as coordenadas de cada vértice

da textura resta apenas dizer onde colocamos esses vértices n
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Figura 69 - (s,t) de uma Textura

Nesta primeira fase de mapeamento de texturas, vamos fazer corresponder diretamente
cada vértice da textura a um vértice do poligono. Assim ficamos com algo como esta na

Figura 70, sendo a textura totalmente mapeada no poligono.

Figura 70 - Poligono com textura

7.2 Mapeamento de parte de uma textura

Como vimos na secgao anterior o mapeamento de texturas consiste em fazer correspon-
der a cada vértice de um poligono coordenadas da textura. Na Figura 70 as coordenadas
usadas da textura correspondem aos vértices da mesma, mas isso nem sempre é o pre-

tendido.

Figura 71 - Representagdo de mapeamento parcial de textura sobre poligono

Imaginemos que queremos usar somente uma parte da textura para cobrir o poligono,
como esta representado na Figura 71. Para fazer isso, e a semelhanga do que foi feito
quando mapeamos a textura toda, temos que escolher os pontos da textura que preten-
demos fazer corresponder aos vértices do poligono, obtendo assim o resultado desejado,

tal como podemos ver na Figura 72.
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Figura 72 - Poligono com parte da textura mapeada

7.3 Replicagcao de uma textura

Nos casos anteriores usamos uma textura para cobrir o poligono inteiro. Imaginemos que
esse poligono corresponde a uma parede, nesse caso provavelmente o efeito visual pre-
tendido é o de repeticdo da textura ao longo da parede. Uma solucgdo inicial seria partir o
poligono inicial em muitos poligonos menores e mapear a textura completa em cada um

dos poligonos obtendo o efeito que se pode ver na Figura 73.

Figura 73 - Mapeamento de textura por replicacdo de poligonos

O problema deste método é que aumentaria rapidamente o nimero de poligonos para
um numero tal que tornaria o conjunto dificil de processar. O que torna esta solucdo
pouco viavel.

Uma outra forma de resolver este problema, mais eficiente, é repetir a textura. O pro-
blema entdo passa a ser "como fazer para replicar a textura?". Para resolver esse pro-
blema necessitamos de responder a uma questdo sobre o mapeamento de texturas: o

gue é que estd para além do valor "1" em cada um dos eixos “s” e “t"?
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Figura 74 - Eixos de uma textura replicada

Como podemos ver na Figura 74, a textura pode ser repetida quantas vezes for necessa-
rio, para totalizar a dimensao necessaria (superior a "1").

Assim, no nosso exemplo, podemos utilizar valores superiores a 1 (ou, por semelhanga,
inferiores a 0), e assim obtermos o efeito desejado: apenas temos que mapear a textura
no poligono com base nesses valores e no nimero de réplicas em ambas as direcdes que

desejamos obter. O efeito final desejado é o que esta representado na Figura 75.

Figura 75 - Poligono com textura replicada

7.4 Listade Texturas no Google SketchUp

No Google SketchUp, as texturas sdo aplicadas com a ferramenta “paint bucket” que é

acessivel através do botdao com o balde que se pode ver na Figura 76.
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Figura 76 - Toolbar principal com indicagdo onde encontrar o “paint bucket”
Para utilizar a ferramenta, deve "clicar-se" sobre o botdao do balde, o que faz abrir uma

janela idéntica a da Figura 77, com a lista de texturas.

| Makeriall

Select ] Edit

l-J|> Q |In Maodel v

[2]

@N & B

Figura 77 - Janela de Selegdo de Materiais

Essa janela pode ser decomposta da forma que se encontra demonstrada na Figura 78.

| Materiall E 1 Mais Opgies
Mome do marerial Criarfeditar
@" Msterial
- Menhom hMaterial

Select lEdit l Selecionador de tipos g—-EYEﬂmlH
de materziz

4: ¢ ‘m |In Model i

Figura 78 - Janela de Selecdo de Materiais com descrigao
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7.5 Colocar Textura sobre um Poligono

Para comecar a colocar texturas num poligono, apenas € necessario selecionar a textura
que desejamos utilizar recorrendo a lista de texturas apresentada e, de seguida, "clicar"

no poligono em que a desejamos colocar, tal como pode ser visto na Figura 79.

@ untitled - SketchUp

File Edit View Camera Draw Tools Window Help

?» /BOC Y RBLIRSEH2AR OO ¥

Wzl
. @
z
»

Select | Edt |

<& (Y inmodel - ;

Figura 79 - Aplicacdo de uma textura a um poligono

7.6 Alterar aforma de uma Textura

Quando a textura se encontrar mapeada no poligono, temos que ajusta-la ao mesmo,
pelo que serad necessario aceder ao modo de edicdo do mapeamento de texturas. Este
modo pode ser ativado "clicando" com o botdo direito sobre o poligono e escolhendo a

opcao “Texture” seguida de “Position” tal como pode ser visto na Figura 80.
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Entity Info

Erase Delete

Hide

Select >
Area >
Intersect »
Align View

Align Axes

Reverse Faces

Orient Faces

Zoom Extents i
Texture »  Position

B — Reset Position

Projected

Figura 80 - Figura demonstrando como entrar em modo de edicdo de uma textura

Nesta altura sobre o poligono podemos ver 4 “pins” com cores diferentes, tal como de-

monstrado na Figura 81.

Click to finish.

Ferramenta de Escalonamento Hori-

zontal

Ferramenta de mover Textura

Ferramenta distorgcao

Ferramenta de Escalonamento Vertical
e rotagdo

Figura 81 - Modo de edigdo

A forma de utilizacdo destas 4 ferramentas é simplesmente por arrasto: basta arrastar o
pin.

Também é possivel mover os pins de posicdo sem utilizar a ferramenta: basta "clicar"
uma vez sobre o pin e, sem o arrastar, "clicar" novamente onde desejar colocar o pin.
Com base neste método de utilizagdo, vamos entdo entender o que faz cada uma destas

ferramentas.
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7.6.1 Mover Texturas

Esta acdo corresponde a ferramenta do pin Vermelho. A posicdo deste pin € um ponto de
referéncia para os restantes "pins", funcionando como centro de rotagdo para a ferra-
menta de rotagdo e como ponto de referéncia para deformacgGes verticais e horizontais
das restantes 2 ferramentas. Também serve para mover a textura ao longo do poligono,

para o que se deve arrastar o pin na direcdo desejada.

7.6.2 Escalar Horizontalmente / Torcer Texturas
Estas acOes correspondem a ferramenta do pin Azul. Arrastando o pin ao longo da linha
vertical que surge quando se utiliza a ferramenta, efetua-se um escalamento da textura

nessa diregao, tal como pode ser visto na Figura 82.

Figura 82 - Exemplo de uma textura esticada horizontalmente

Da mesma forma pode ser movido na direcdo horizontal: o pin faz com que a textura se-
ja torcida na direcdo em que se for movido, dando o efeito que pode ser visto na Figura
83.

Figura 83 - Exemplo de uma textura torcida
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7.6.3 Compresséao/ Distorgdo de Texturas

Estas acGes correspondem a ferramenta do pin amarelo. Arrastar este pin na direcdo ver-
tical tem o efeito de comprimir ou esticar a textura nessa direcao. Este processo aconte-
ce inversamente para cada um dos lados (esquerdo e direito) da textura, isto €, quando
do lado esquerdo a textura estica, do lado direito ela comprime e vice-versa. Tal como
acontece com os lados esquerdo e direito quando é movido verticalmente, acontecera
também com os lados do topo e da base quando o mesmo pin for movido horizontalmen-
te (Figura 84 e Figura 85).

Figura 84 - Exemplo de distor¢do horizontal

Figura 85 - Exemplo de distorcdo vertical

7.6.4 Escalar Verticalmente / Rodar Texturas

Ao arrastar o pin Verde, a textura rodara em torno do centro (que corresponde ao ponto
onde se encontra o pin Vermelho). Esta ferramenta também permite esticar a textura ho-
rizontalmente se o pin Verde for afastado do centro de rotagdo, ou comprimi-la, se o
mesmo for aproximado do centro.

Estes efeitos podem ser vistos na Figura 86 e na Figura 87.
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Figura 86 - Exemplo de uma textura comprimida verticalmente

Figura 87 - Exemplo de uma textura rodada
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7.7 Exercicio Préatico de Texturas

1 - Criar um dado.

i A planificacdo do dado deve seguir o seguinte esquema:

ii. A face 1 deve ficar voltada para cima e o 3 para a frente.

iii. O resultado final deve ser o seguinte:

2 — Apods realizada a tarefa, mudar a cor do dado para vermelho.
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8 Componentes

Os componentes no SketchUp sdo conjuntos de poligonos guardados como um todo. No
SketchUp, podemos, ja apds a instalagdo, encontrar variadissimos objetos, numa biblio-
teca organizada em galerias por motivo. Para aceder a estes objetos, podemos abrir a
janela Components (Figura 88), a partir do menu Window. (Window -> Compo-

nents).

Components |:|
. .
”z ©
Select |Edic | Statistics |
¢I E{} {h |Landscape j [3

Figura 88 - Galeria Landscape na janela Components

8.1 Como utilizar Componentes

Além dos diversos componentes ja incluidos na instalacdo do programa, podemos aceder
a outros mais, numa biblioteca online chamada 3D Warehouse, Figura 89. Podemos
também, nesta galeria online, disponibilizar os nossos trabalhos, para o que é apenas
necessario possuir uma conta Google.

Para utilizarmos componentes online, abrimos o menu File e selecionamos 3D Ware-
house->Get Model; para partilharmos os nossos modelos com a restante comunidade,

selecionamos 3D Warehouse->Share Models.
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™
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Google

Search for:
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Search |

Google Picks
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g Google SketchUp
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‘
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Sketchlp
Components

Popular Models
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BhdWy M3 GTR set
by superlernurdd by Rocky

Use
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showcase and
organize
models.

Create a collection
Contribute to a collection
Browse collections

bathroorm
by Stephanie

Figura 89 - 3D Warehouse

Para criar componentes, selecionamos os objetos que queremos que passem a constituir

um componente e

"clicamos" no icone

&

2

(Make Component); alternativamente,

através do menu Edit, selecionando a opgdo Make Component.

46




Create Component

General

Mame: | Componental

Description:

Alignrment

alue ko: |Mone vl Set gluing plane|
|

[ Always Face camera

=

|v Replace seleckion with component

Cancel | Create |

Figura 90 - Janela Create Component

Apds termos criado um componente, podemos encontra-lo na janela Components, Figu-
ra 90 e coloca-lo na cena quantas vezes quisermos. Isto é util, por exemplo, se quiser-
mos replicar diferentes janelas num mesmo edificio. Criamos um componente para uma
janela e, replicando-o tantas vezes quantas as necessarias, conseguimos construir o nos-

so edificio de forma mais rapida e eficaz.
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9 Camaras

As camaras, como objeto, sdo representagoes de perspetivas, definindo o que o utilizador
ou espetador vé. As camaras sao definidas pelas suas componentes, entre elas a posicao,
a orientagdo e o campo de visdo. A posicdo de uma camara é o local no espago de onde
se observa a cena. A orientagdo corresponde a direcdo segundo a qual observamos. O
campo de visdo é a amplitude angular da vista; em termos praticos, influencia aquilo a
que normalmente chamamos "zoom".

As figuras Figura 91 e Figura 92 sdo provenientes de outro programa de modelagao e

tentam mostrar uma cdmara e a imagem que ela se encontra a captar.

Figura 91 - Representagdo de uma camara como objeto.

Figura 92- Vista através da mesma camara

Definimos a posicdo de uma camara com um ponto (coordenadas no espago); a orienta-

cao é definida por um vetor com inicio no ponto de posicdo; o campo de visdao é definido
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por um angulo. Podemos ver isso representado na Figura 93.

Figura 93 - Componentes da Camara.

9.1 Utilizagdo de Camaras em SketchUp

No SketchUp existem varias cdmaras standard; entre elas, destacam-se Top, Front, Left
e Iso; correspondem, respetivamente, a vistas de Topo, Frente, Esquerda e perspetiva
Isométrica. As diferentes perspetivas sao Uteis para criar ou modificar objetos, facilitando
e, por vezes, garantindo, os resultados esperados.

Por exemplo: no caso de precisarmos de mover um objeto e quisermos evitar mové-lo na

vertical é conveniente utilizar uma camara correspondente a vista de Topo (Figura 94).
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& Untitled - SketchUp E]@

File Edt View Camera Draw Tools ‘Window Help
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Top
IJse Select tool, or pick one thing to movejrotate Length [1,94m

Figura 94 - - Objetos vistos de cima. (Top view).

Ao contrario de outros programas de modelacdo 3D ndo temos, no SketchUp, acesso a
camaras como objetos. No entanto, podemos, para simular multiplas camaras, utilizar di-
ferentes cenas (Scenes).

Para isso, basta abrir a janela Scenes (Figura 95) no menu Window-> Scenes.

®LC £ =
Scene 1
Scene 2

Scene 3
Scene 4

v Include in anirmation

Mame: | Scene 4

Descripbion:

Properties
ko save:

Camera Location

Hidden Geometry
VWisible Layers

Active Section Planes
Drawing Skyle

<l <] =} Rl <l <<

Shadow Setkings
Axes Locakion

Figura 95 - Janela Scenes.
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De seguida, adicionamos tantas cenas quantas as diferentes perspetivas desejarmos, uti-
lizando o botdo com o sinal "+". Selecionando uma cena, podemos entdao definir quais as
caracteristicas a memorizar e alterar o seu campo de visdo, posicao, etc. Para especificar
a posicdo de uma camara, podemos utilizar uma ferramenta chamada Position Camera.
(menu Camera-> Position Camera).

Com esta ferramenta ativada, "clica-se" e arrasta-se para escolher o ponto de posicdo e
a orientacdo. Por exemplo, na Figura 96, a camara correspondente a "cena 4" foi coloca-

da sobre a cena e um pouco a frente da mesma.

@

P ABOC CGdRBILRDF HZAR OO ©Y
Scane 1| Scene 2| Seens 3 Eoena s

Aba "Scene 4"

Figura 96 - Camara da Cena 4.

9.2 Exercicio

Comeca por reiniciar o teu ambiente de modelacdo, selecionando no menu File a opgao
new. Grava o ambiente anterior, se assim desejares, ou te for pedido. No menu Came-
ra, certifica-te que tens a opgao Parallel Projection selecionada.

Faz a importacao, do menu dos componentes, de um banco de jardim e coloca-o no teu
ambiente de modelacao, ficando uma perna na origem das coordenadas.

Abre a janela Scenes e adiciona cenas até um total de 5:

1) Escolhe a primeira cena e, utilizando apenas os controlos pan e orbit, coloca a
tua visao de frente para o banco, o melhor que conseguires.

2) Na segunda cena, escolhe uma visao frontal, mas através do menu. (Camera -
> Standart Views -> Front).

3) Compara resultados entre as cdmaras anteriores e apresenta conclusoes.
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4)

5)

6)

Na tua terceira cena, utilizando uma camara adequada, conta quantas tabuas

compdem o banco.
Na quarta cena, utiliza a ferramenta Position Camera, de forma a ficares a

ver o banco de lado.
Na quinta e ultima cena, escolhe uma camara que seja do teu agrado.
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10 Animacgao

A animacdo é uma sequéncia de imagens coerentes que, quando observadas rapidamen-
te, dao a ilusdao de continuidade.
Para uma animacao ser vista com fluidez, ou seja, sem "saltos entre imagens", é neces-

sario que seja desenhada com, pelo menos, 12 imagens por segundo (idealmente 24).

10.1 Como produzir uma Animagdo em SketchUp?

O SketchUp nao é dos melhores programas para realizar animacdo de objetos. As anima-
cOes que permite efetuar sdo apenas animagdes de camara, de luz ambiente e sombras.
Para se conseguir uma animacdo no SketchUp, é necessario criar duas ou mais cenas.
Apés criadas e devidamente configuradas do modo que queremos, pedimos ao programa
que simule a passagem de uma cena para a outra. Por exemplo: no caso de termos dife-
rentes cenas, cada qual com a sua Camara, podemos criar uma animacdo de movimento
de cada camara para a seguinte. Esta € uma animacdo comum denominada, no
SketchUp, por Fly-by.

Para corrermos uma animacdo, € apenas necessario "clicar" com o botdo direito do rato
num separador e escolher Play Animation. Podemos, de outra forma, no menu View,
selecionar Animation e, de seguida, Play Animation. Desta forma abrimos a Janela

Play Animation, Figura 97.

Animation

00 Pause | [ Stop |

Figura 97 - Janela Play Animation

10.2 Exercicio

Comeca por reiniciar o teu ambiente de modelagdo, selecionando, no menu File, a opgao
New. Grava o anterior trabalho, se assim desejares ou te for pedido.

Utilizando o que ja aprendeste sobre componentes, cria uma arvore utilizando os compo-
nentes disponiveis, perto do ponto de origem do referencial.

Cria 3 cenas:

e Na primeira, p6e a camara longe e observando de cima, mas certificando-te de
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gue a arvore estd mais ou menos centrada na imagem. Faz update da cena, "cli-
cando" com o lado direito num separador da respetiva cena e selecionando upda-
te.

Na segunda cena, coloca a camara perto e de frente para a arvore; ndo se deve
ver o topo da arvore, mas deve ver-se a sua base. Faz update da cena.

Na terceira cena, coloca a camara num outro angulo de perspetiva, de forma a
ver a arvore pelo outro “lado”; certifica-te, no entanto, de que toda a arvore este-
ja visivel. Faz update da cena.

Corre a animacao.
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